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Getting ready
New to ProSeries or just need some refresher training?  
Please visit our New User Welcome Center at accountants.intuit.com/training-center/
proseries for an awesome training experience complete with live and recorded webinars 
along with resource material to get you started.  

•	 For information about What’s New with ProSeries for the current tax year (such as 
form and calculation changes) refer to the ReadMe files located in the Help Center.

•	 For detailed information about current System Requirements, go to: 
https://accountants.intuit.com/tax/proseries/professional/system-
requirements.jsp

•	 With Windows 8 and 10 operating systems for PCs and tablets you must use a 
mouse and keyboard for optimal input experience. Touchscreen input has not been 
tested and is not supported.

Installing ProSeries software for stand-alone use
You install ProSeries software from files you download from ProSeries.com (via the Internet) or 
from a ProSeries CD.

1	 Close all programs.

2	 If you’re installing from a ProSeries CD, insert the CD into the CD drive.

If you’re installing from an .EXE file that you downloaded from ProSeries.com, 
navigate to the location where you saved the download, then double-click the .EXE file.

3	 In the ProSeries Installation dialog box, select Install ProSeries Software.

Note: For installing to a Network, go to page 8
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2	 ProSeries Quick Reference Guide

Tip: If you’re installing from a ProSeries CD and the ProSeries Installation dialog box 
doesn’t appear automatically, go to the Windows taskbar, select Computer, then locate 
your CD drive containing the ProSeries CD. Double click on the drive to browse the files 
on the ProSeries CD. Now locate and double click the CDSetup to start the ProSeries 
installation.

4	 Follow the instructions on the screen. Specific dialog boxes are discussed next.

5	 If a System Warning dialog box appears, select Cancel, correct the situation identified 
in the dialog box, then start the installation procedure again.

6	 In the Software License Agreement dialog box, select I accept the terms of the 
license agreement if you agree to accept all the terms of the ProSeries License 
Agreement, then select Next.

Important: If you find the terms of the License Agreement unacceptable, do not 
install the software.

7	 In the Select an Installation Type dialog box, select Stand Alone, then select Next.

8	 In the Select Destination Directory dialog box, select Next to install ProSeries 
software in a \PROWINyy directory (where “yy” represents the last two digits of the tax 
year) on the drive that’s shown in the dialog box.

Tip: If you want to install ProSeries software to a different drive or directory, click 
Browse. In the Select Folder dialog box, select the drive you want, type the folder name 
\ProWinyy in the Folder name field (where “yy” represents the last two digits of the tax 
year) after the drive you selected, then select OK.

9	 In the Product Selections dialog box, select every ProSeries tax products that you 
expect to use, then select Next. 

Tip: If you used ProSeries software last year, products that were installed last year 
might already be selected. Products you haven’t purchased as unlimited will be installed 
as pay‑per‑return. You can install additional products later, as described in “Keeping your 
ProSeries tax products up-to-date” on page 14. 

These check boxes are for federal 
products. The check boxes to the right 
of the Federal Products  
section are for state products.

Tip: At least one federal product must 
be selected. If you select a state 
product, be sure to select the 
corresponding federal product.

Tip: Being selective on this screen will 
eliminate the need for unnecessary 
notifications that do not apply to you.  
This will reduce the storage space for 
your platform and the number of 
download updates. It is easier to add 
additional tax modules and/or states 
to your platform than it is to uninstall 
unnecessary products.
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10	 If any of the products you selected aren’t available, you’ll see the Installation Note 
dialog box. Review the list of products that will be installed later, then click OK. 
Note: Products that are not available will automatically be installed by the ProSeries 
Task Scheduler when they become available. If you choose to not to use the ProSeries 
Task Scheduler, you will need to manual check for updates.

11	 Review the information in the Installation Details dialog box, then click Next to install 
the ProSeries tax products you selected that are available. 

Important: If you see the Installation Failed dialog box, click Help to find a possible 
solution, then click Exit to exit the installation program.

12	 Restart Windows message. If you are prompted to restart your computer, do so. If the 
installation program doesn’t resume, double-click the ProSeries shortcut icon on your 
Windows desktop to start the ProSeries program.

13	 Setup Complete. If you leave the check mark in the Launch ProSeries option in the 
Setup Complete dialog box, the Connected Customer Wizard begins when you select 
Finish.
Tip: If you see the ProSeries Installation dialog box, select Exit to return to the 
Windows desktop, then start ProSeries program by double-clicking the ProSeries 
shortcut icon. The Connected Customer Wizard will begin. 

Troubleshooting suggestions
If you have difficulty installing or starting the ProSeries program:

●● Start your Internet browser, then go to my.proseries.intuit.com/support to search for 
additional troubleshooting solutions.

●● If you have an issue requiring ProSeries Technical Support, go to my.proseries.intuit.
com/contact_us to review all available support options. To save time, gather as much 
information as possible, including any error messages, before contacting chat or phone 
support.

Setting up the ProSeries program
The first time you start the ProSeries program, the Connected Customer Wizard helps you set 
up the program if there’s a valid Internet connection.

●● Firm information. Retrieves the name and address of your firm.

●● Product licensing. Licenses your ProSeries tax software to your firm.

●● Product updates. Downloads and applies the updates for installed products, if any.

●● New products. Downloads and installs not-yet-installed products, if any.

Tip: If the computer doesn’t have a valid Internet connection, a dialog box asks if you want 
to start the Internet Connection Setup Wizard. Select Yes to establish an Internet connection, 
or select No to establish a valid Internet connection at a later time.
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Using the Connected Customer Wizard
1 In the Connected Customer dialog box, select Next.

2 Enter or verify your Customer Number and the ZIP code in the Customer Information dialog 
box, then select Next.

3 Select Next after the Connected Customer Wizard finishes the setup tasks.

4 Review the information in the Verify Firm Information dialog box carefully. ProSeries 
program prints this information on all returns prepared by your firm.

If the information is correct, select Yes. If the information isn’t correct, select No. Select 
Next, then go to Step 8 if you selected Yes or go to Step 5 if you selected No.

5 Enter or edit your firm’s name and address in the Enter Firm Information dialog box, 
then select Next.

6 The wizard transmits the updated information to an Intuit server, or a dialog box 
instructs you to call Customer Service. Select OK to continue.

7 Review the firm and product information in the Product Licenses dialog box.

8 If the ProSeries Update program downloads and installs products and product updates, 
review the status of each product ProSeries Update dialog box, then select Close.

When the Connected Customer Wizard or ProSeries Update program finishes, the ProSeries 
program starts. The first time the ProSeries program starts, the Prior Year Settings 
Transferred dialog box appears if the program was able to transfer the preferences and 
settings you used with last year’s program. 

Important: The ProSeries Login dialog box opens if (and only if) you used the Access 
Rights feature in last year’s ProSeries program and last year’s Access Rights information was 
transferred. Enter a valid User Name and Password, then click OK to proceed.

These numbers should match the 
Customer Number and ZIP code 
that are printed in the Sold To: 
area of your packing slip. If you do 
not have a packing slip you can 
verify your customer number by 
logging in to your My Account  
on www.taxpro.intuit.com/
proseries.

A different Customer Number and 
ZIP code might appear in the Ship 
To: area of your packing slip.
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Using the Connected Customer Wizard
1 In the Connected Customer dialog box, select Next.

2 Enter or verify your Customer Number and the ZIP code in the Customer Information dialog 
box, then select Next.

3 Select Next after the Connected Customer Wizard finishes the setup tasks.

4 Review the information in the Verify Firm Information dialog box carefully. ProSeries 
program prints this information on all returns prepared by your firm.

If the information is correct, select Yes. If the information isn’t correct, select No. Select 
Next, then go to Step 8 if you selected Yes or go to Step 5 if you selected No.

5 Enter or edit your firm’s name and address in the Enter Firm Information dialog box, 
then select Next.

6 The wizard transmits the updated information to an Intuit server, or a dialog box 
instructs you to call Customer Service. Select OK to continue.

7 Review the firm and product information in the Product Licenses dialog box.

8 If the ProSeries Update program downloads and installs products and product updates, 
review the status of each product ProSeries Update dialog box, then select Close.

When the Connected Customer Wizard or ProSeries Update program finishes, the ProSeries 
program starts. The first time the ProSeries program starts, the Prior Year Settings 
Transferred dialog box appears if the program was able to transfer the preferences and 
settings you used with last year’s program. 

Important: The ProSeries Login dialog box opens if (and only if) you used the Access 
Rights feature in last year’s ProSeries program and last year’s Access Rights information was 
transferred. Enter a valid User Name and Password, then click OK to proceed.

These numbers should match the 
Customer Number and ZIP code 
that are printed in the Sold To: 
area of your packing slip. If you do 
not have a packing slip you can 
verify your customer number by 
logging in to your My Account  
on www.taxpro.intuit.com/
proseries.

A different Customer Number and 
ZIP code might appear in the Ship 
To: area of your packing slip.

Using the Options Setup Wizard
The Options Setup Wizard usually automatically runs the first time the program starts. If it 
does not automatically start, click the Help button on the ProSeries toolbar then click Options 
Setup Wizard. The Options Setup Wizard helps you set up ProSeries options. Most Options 
Setup Wizard dialog boxes are self‑explanatory. Note the following:

●● The Options Setup Wizard dialog boxes will display options you need to set before  
you complete any returns.

●● When the Congratulations dialog box appears, select Finish to save the options that 
you selected.

You can set up E‑File options and Bank Products Enrollment/Registration Information using 
the Options Setup Wizard.  

For more information about offering bank products use the Search Help feature on the 
toolbar or in the Help Center.

The next sections discuss “Entering firm and preparer information” and “Entering global  
billing information” in some detail.

Tip: For information about a field in a dialog box, right mouse click the field, then select 
About <Field> on the pop‑up menu.

Entering firm and preparer information
If you completed the Connected Customer Wizard, you’ll see your firm’s name and address in 
the gray area of the Firm Information section.

Enter other information about your firm in the fields below the gray area. If the firm will be 
filing returns electronically, enter the firm’s Electronic Filing Identification Number (EFIN) 
 and the name of the person that ProSeries Technical Support can contact if necessary.

During the product licensing procedure, 
your firm’s name and address are  
retrieved from an Intuit Internet server, 
select your firm name to enter information 
about your firm. 

Select an existing preparer or click to add a 
new preparer to enter information about 
the preparers in your firm.

To move to new fields, press ENTER or TAB, 
or use your mouse.
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If your firm will be filing returns electronically, enter ERO Information about each EFIN. 

Important: When an Electronic Filing Identification Number (EFIN) is entered for either 
the firm or a preparer, you will also be 
required to verify the Electronic Return 
Originator name and address that are 
registered with the IRS. Intuit uses this 
information to verify IRS Authorized 
e-file providers so the information 
provided must match the IRS ERO 
records.

Tip: If the ProSeries program 
transferred preparer information from 
last year’s program, just edit the 
information as necessary.

Entering global billing 
information
Use the Global Billing Options dialog box to set the billing options that you want to use for 
all clients. If the ProSeries program transferred global billing information from last year’s 
program, just edit the information as necessary.

This dialog box helps you set up:

1	Tax Preparation Fees

2	Hourly Charges

3	Per Form Charges

4	Other Billing Options

Important: To complete additional 
Global Billing set-up such as Rates Per 
Form and to edit the invoice go to 
Tools, Billing from within an open 
return. 

Transferring data from last year’s ProSeries client files
The first time you start the ProSeries program, you can transfer relevant data from last year’s 
client files to new ProSeries client files for this year. If you used ProSeries software last year, 
select Yes to go to the Transfer window, then do the five steps listed on the left side of the 
Transfer window.

Electronic filing. If last year’s return was marked for electronic filing, that selection is 
transferred to this year’s return.

10352_507041_f1.indd   6 10/7/15   6:25 AM



Filing returns electronically	 7

1.	 Select the type of transfer you want to 
perform from the list of alternatives.

2.	 Select the location of your existing 
client files.

3.	 Select a location for the new client files.

4.	 Select the client files that you want to 
transfer data from, or click the Select 
All button.

5.	 After you’ve selected one or more 
clients, click Transfer.

The Transfer Log dialog box opens when the ProSeries program finishes transferring client 
data. Review the information, then select Close to go to HomeBase.

Filing returns electronically
ProSeries/Electronic Filing is installed with ProSeries Tax products that support e-filing. To e-file 
returns in ProSeries, you must be an Authorized IRS e-file Provider with a valid IRS issued EFIN. 
We only accept and transmit returns from Authorized IRS e-file Providers, set forth in IRS 
Publications 3112 and 1345. Select one of the options below for more details about e-filing.

1.	 Use the Search Help feature in the tax program located in the Help Menu

2.	 Click the User’s Guide icon in tax program tool bar, then go to chapter 20, 
“Electronic Filing.”

Establishing an Internet connection
To e-file, the computer on which the ProSeries program is installed must be able to connect to 
the Internet. If you don’t have an Internet connection, you must first sign up for service with 
an Internet Service Provider (ISP). Once you have an ISP, go to the Help menu, select 
Internet Connection Setup, then follow the on-screen instructions.
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Installing ProSeries software for network use
Installing and setting up ProSeries software for network use involves the following three steps:

	 Step 1: Install to this computer (ADMIN workstation)
	 Step 2: Complete Licensing (Connected Customer)
	 Step 3: Install to other network computers (USER workstations)
Note that certain details vary from system to system. If you have additional questions about 
network installation:

1	 Start your Internet browser, then go to proseries.com.

2	 From the ProSeries.com home page, select Support.
3	 Type a question in the Ask ProSeries field, then select Search.

Tip: If you want help optimizing ProSeries software on your network, go to  
 accountants.intuit.com/contact/proseries.jsp to review all available support options.

Prepare your networked computer system
Before you can install ProSeries software, you must prepare your networked computer system. 
The specific steps appropriate for your system depend on the type of network and the way it’s 
set up. The table below explains some network-related terms.

Term Explanation

Client-server network A network setup where only one computer (the server) shares resources 
used by one or more workstations (the clients).

Peer-to-peer network Up to 10 computers that are linked together. One or more systems may 
share resources.

Mapped drive Any drive or shared resource that has a drive letter assigned to it.

ProSeries ADMIN 
workstation

The computer from which ProSeries software is installed to the server or 
serving computer. You can designate any computer to be the ProSeries 
ADMIN workstation (including the network administrator’s computer), 
but once you choose a ProSeries ADMIN workstation, it should remain 
the ProSeries ADMIN workstation throughout the tax season.

ProSeries User 
workstation

A computer that runs the ProSeries program and accesses the ProSeries 
network components from the shared folder.

Shared folder The folder that is set up by the Network Administrator to be shared in the 
network system. The ProSeries shared folder is the location where 
ProSeries network components and client files reside.)

Primary file location This is the location where the program stores all current-year client files. 
This location can be set only from the ProSeries ADMIN workstation.
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For instructions related to shared folders, mapped drives, rights, and permissions, refer to the 
documentation for your operating system and/or network software. If you have additional 
questions about preparing your networked system for the network version of ProSeries, go to 
proseries.com, select Support, type a question in the Ask ProSeries field, then select Search.

Take the following steps before you begin the ProSeries installation procedure.

1	 Decide which drive on the server (if a client-server network) or the serving computer  
(if a peer-to-peer network) you will install ProSeries shared network components.

2	 On the drive you chose, create a folder named ProSeries.

3	 Make the ProSeries folder a shared folder, and assign it the name “ProSeries.”

4	 Within the ProSeries folder, create a folder named ProNetyy (where “yy” represents 
the last two digits of the tax year).

5	 Decide which computer will be the ProSeries ADMIN workstation. Use the following 
information to help you decide.

•	 Internet access. An Internet connection is required.

•	 If a client-server network. You install ProSeries software from the ProSeries ADMIN 
workstation to the server’s hard drive. The ProSeries ADMIN workstation and the 
server are two different computers. The ProSeries ADMIN workstation can be used as 
a workstation, but the server is not used as a workstation because doing so can 
degrade network performance.

•	 If a peer-to-peer network. You install ProSeries software on the ProSeries ADMIN 
workstation’s hard drive. The ProSeries ADMIN workstation can be used as a 
workstation.

•	 Rights. The ADMIN workstation is the only computer that has rights to at least some 
aspects of the following features: Product Updating, Customer Information, Primary 
File Location, Firm Name and Address, Master Password, Electronic Filing Password, 
Bank Products Registration Information, Database Maintenance, and HomeBase 
Tune-up.

6	 Make sure a drive is mapped to the ProSeries folder on the server or serving computer. 
Make sure the ProSeries ADMIN workstation has the appropriate rights and permissions.

7	 Go to each computer that will serve as a ProSeries User workstation, then make sure a 
drive is mapped to the ProSeries folder on the server or serving computer. Make sure 
each User workstation has the appropriate rights and permissions.

Map drive factors to consider 
We recommend you use mapped drives (rather than UNC), and that the drive with the 
ProSeries shared network components be mapped to the same drive letter for all workstations.

Mapped to same drive letter. If you’re an existing ProSeries network user and have all 
computers mapped to the same drive letter, you don’t have to change anything. Install 
ProSeries software as you did in prior years
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Mapped to different drive letters. If all of your workstations are mapped to a network 
shared folder using different drive letters, you don’t have to re-map the workstations.

New computers. If you’re an existing ProSeries network user and you’ve added new 
computers to your network, we recommend you set them up the same way as the existing 
workstations on your network.

New user. If you are installing ProSeries software for the first time, you can install ProSeries 
shared network components directly to a shared folder without mapping drives. You can run 
the workstation installation and setup from all other computers by accessing this shared 
folder.

UNC instead of mapped drives. UNC stands for “Universal Naming Convention” or “Uniform 
Naming Convention.” UNC uses the following format:

\\server-name\shared-folder-path

If you use UNC instead of mapped drives, the shared folder doesn’t have to be mapped to a 
network letter as long as all workstations can access the shared folder. However, if you use 
UNC instead of mapped drives, you must use UNC exclusively.

Step 1 and Step 2: Install and set up ProSeries software 
from the ADMIN workstation
Installing ProSeries software from the ADMIN workstation for network use is similar to 
installing ProSeries software for stand-alone use with the following exceptions:

1	 In the Select an Installation Type dialog box, select Network, then select Next.

2	 When the Review Network Installation Steps dialog box appears, review the 
summary of the three steps required for network installation, then click Next.

3	 In the Computer Name dialog box, enter a name for the current workstation (such as 
the name of the person who typically uses the workstation), then click Next.

4	 In the Choose Destination Location dialog box, accept the recommended locations 
for the Local Folder and Network Folder unless:

•	 Local Folder. You want the ProWinYY folder (where “YY” represents the last two 
digits of the tax year) on a local drive other than C:\.

•	 Network Folder. If the suggested location isn’t appropriate or the Network Folder 
field is blank, select the ProNetYY folder (where “YY” represents the last two digits of 
the tax year) within the ProSeries folder that you created on the server or serving 
computer.

10352_507041_f1.indd   10 10/7/15   6:25 AM



Installing ProSeries software for network use 11

If you accept:

*  The location 
shown in the 
Local Folder  
field, and

*  The location 
shown in the 
Network Folder 
field (if a location 
is shown), then

Click Next.

If you want to 
select a 
different local 
location, click 
this Change 
button.

If you want to 
enter or select 
a different 
network 
location, click 
this Change 
button.

If you accept the recommended folders, click Next and proceed to Step 5 .

If you don’t accept the Local Folder:
a. Select the local drive where you want to install the ProSeries program.

b. Go to the Path field, type ProWinYY (where you type the last two digits of 
the tax year in place of “YY”) after the drive that you selected, then click OK. 
If you are prompted to create the ProWinYY folder, click Yes.

c. Continue with Step 5 .

If you don’t accept the Network Folder: 
a. Select the drive where you want to install the ProSeries shared network 

components.

b. Go to the Path field, then type “ProSeries\ProNetYY” (where you type the 
last two digits of the tax year in place of “YY”) after the drive you selected, 
then click OK. If you are prompted to create the ProSeries or ProNetYY 
folder on the drive that you’ve selected, click Yes.

c. Continue with Step 5 .

5 When the Step 2: Complete Licensing (Connected Customer) dialog box appears, 
review the summary of the next steps, then click Next.

6 Connected Customer Wizard. If the product licensing information that was 
downloaded by the Connected Customer Wizard didn’t include a Network License.  
You’ll see the Your Network License is Missing dialog box.

•	 Select License Now then call Customer Service to resolve the issue, or

•	 Select Continue without licensing then click OK.
7 User workstation installation instructions. Click Print so you can refer to a printed 

copy of the instructions while you are installing the software and setting up each user 
workstation.
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Step 3: Set up each ProSeries User workstation
Installing ProSeries software to each workstation is similar to installing ProSeries software for 
stand-alone use with the following exceptions:

From each ProSeries User workstation:

1 Go to the Windows taskbar, click Start, select Run, enter the path that’s identified in the 
User workstation installation instructions, then click OK.

Tip: That path will probably be x:\ProSeries\ProNetYY\WKSTN\setup.exe, where x 
represents a drive on your system (but not necessarily Drive X), and “YY” represents the 
last two digits of the current tax year.

This example shows a path that starts with 
Drive N.

This field is not case sensitive.
Letters can be upper-case or lower-case.

2 Follow the instructions on the screen.

3 In the Choose Destination Location dialog box, accept C:\ProWinYY as the 
recommended location for the Local Folder, or select a different local drive for the 
ProWinYY folder (where YY represents the last two digits of the tax year).

4 In the Computer Name dialog box, enter a name for the User workstation (such as the 
name of the person who typically uses the workstation), then click Next.

5 The HomeBase Reconciliation dialog box appears if the ProSeries program detects 
that the HomeBase database on the User workstation needs to be updated with the 
latest information in the client files stored with the shared network components.

This progress bar keeps you 
informed about status of the 
HomeBase Reconciliation 
operation.

6 Network License. If the product licensing information that was downloaded by the 
Connected Customer Wizard didn’t include a Network License, follow the instructions in 
the Network License Missing dialog box to resolve the situation.

Important: You can’t print or e-file returns until your ProSeries software is licensed.
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Step 3: Set up each ProSeries User workstation
Installing ProSeries software to each workstation is similar to installing ProSeries software for 
stand-alone use with the following exceptions:

From each ProSeries User workstation:

1	 Go to the Windows taskbar, click Start, select Run, enter the path that’s identified in the 
User workstation installation instructions, then click OK.

Tip: That path will probably be x:\ProSeries\ProNetYY\WKSTN\setup.exe, where x 
represents a drive on your system (but not necessarily Drive X), and “YY” represents the 
last two digits of the current tax year.

This example shows a path that starts with 
Drive N.

This field is not case sensitive.
Letters can be upper-case or lower-case.

2	 Follow the instructions on the screen.

3	 In the Choose Destination Location dialog box, accept C:\ProWinYY as the 
recommended location for the Local Folder, or select a different local drive for the 
ProWinYY folder (where YY represents the last two digits of the tax year).

4	 In the Computer Name dialog box, enter a name for the User workstation (such as the 
name of the person who typically uses the workstation), then click Next.

5	 The HomeBase Reconciliation dialog box appears if the ProSeries program detects 
that the HomeBase database on the User workstation needs to be updated with the 
latest information in the client files stored with the shared network components.

This progress bar keeps you 
informed about status of the 
HomeBase Reconciliation 
operation.

6	 Network License. If the product licensing information that was downloaded by the 
Connected Customer Wizard didn’t include a Network License, follow the instructions in 
the Network License Missing dialog box to resolve the situation.

Important: You can’t print or e-file returns until your ProSeries software is licensed.

Product licensing
Product licensing is a system that licenses your ProSeries tax software to your firm. Product 
licensing is required before you can print returns, file returns electronically, or create PDF files 
that contain returns. Products that aren’t licensed for unlimited use can be used on a 
pay‑per‑return basis.

Product licensing uses your Customer Number and ZIP code with information in Intuit’s 
records to deliver the following to your ProSeries tax software:

●● An unlimited-use license for each ProSeries tax product and ProSeries electronic filing 
product that you’ve purchased for unlimited use—even if those products haven’t been 
installed yet

●● Your firm’s name and address

●● A network license (if you purchased ProSeries/Network Version)

Tip: You can make minor changes to your firm’s name and address (such as changing “Dr.” to 
“Drive”) after ProSeries product licensing has occurred.

ProSeries product licensing can be performed using the Online method or the Manual 
method. For most ProSeries users, product licensing occurs online automatically.

Automatic, Online product licensing
The Connected Customer Wizard performs product licensing automatically when:

●● You install ProSeries tax software for stand-alone use on a computer that has an Internet 
connection

●● You install ProSeries tax software for network use from a computer (referred to as the 
ProSeries Admin workstation) that has an Internet connection

Important: When ProSeries is installed for network use, product licensing must be initiated 
from the ProSeries Admin workstation. Product licensing information is shared by all 
computers that have been set up as ProSeries workstations. 

Be sure to read “Keeping your ProSeries tax products up-to-date” on page 14 of this guide.

Product licensing with multiple, non-Internet computers
If you installed ProSeries for stand-alone use on computers that don’t have an Internet 
connection and you don’t want to perform product licensing for each computer using the 
Manual method, here’s a convenient way to copy your firm’s product licensing information 
from one computer to other computers.

1	 From the computer with your firm’s product licensing information, go to the File menu, 
select Copy Product License, then use the dialog box to save the product license file to 
a network location or removable media (such as a flash drive).
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2	 From each computer that requires product licensing, go to the File menu, select 
Retrieve Product License, then use the dialog box to retrieve the product license file 
that you copied to the network location or removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

Updating your firm’s product licensing information
Update your firm’s product licensing information when:

●● You purchase additional ProSeries tax products or additional ProSeries electronic filing 
products for Unlimited use, or

●● You purchase ProSeries/Network Version, or

●● The software or an Intuit ProSeries representative instructs you to update your product 
license information

If either of these situations occur, go to the Tools menu, select License Products, select 
Online, select OK, then simply wait for the product licensing procedure to conclude.

Tip: If the computer isn’t connected to the Internet, go to the Tools menu, select License 
Products, select Manual, select OK, then follow the instructions in the License Products 
dialog box shown on page 12.

For more information about product licensing:

●● Use the Search Help feature on the Help toolbar or in the Help Center, or

●● Click the Help button on the toolbar, select User’s Guide in the Help Center,  
then go to chapter 4, “Setting Up ProSeries Features.”

Keeping your ProSeries tax products up-to-date
As soon as a ProSeries tax product or tax product update becomes available, it is posted to a 
ProSeries Internet server. Getting products and updates via the Internet helps you have the 
most up‑to‑date versions of the tax products you use.

Network: Most product updating activities must be performed from the ProSeries ADMIN 
workstation.

Task Scheduler
Use the Task Scheduler to Save time and never miss a critical update by scheduling selected 
tasks to run automatically. Your computer must be running and connected to the Internet 
when tasks are scheduled to run.
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Using the Task Scheduler program
1	 In ProSeries, go to the Tools menu, select Options, then select Task Scheduler.

2	 Make sure the Download New/Update Existing Products task is enabled.

3	 To change the Task Scheduler schedule, select Modify.

Using the ProSeries Update menu
1	 In ProSeries, go to the Update menu and select Update Installed Products if you 

don’t want to select additional products for installation.

2	 In ProSeries, go to the Update menu and select Select and Download New Products 
if you want to select additional products for installation.

Tip: ProSeries will automatically default to run the Task Scheduler. To change this selection, 
go to the Update menu and select Automatic Updates (Task Scheduler).

10352_507041_f1.indd   15 10/7/15   6:25 AM



Client Benefit Suite Terms and Conditions
Pay-by-Refund
*Offer is available for current ProSeries and Lacerte customers only for a limited time only. Credit applies to Pay-by-Refund 
transactions through a participating bank only. Participating banks are Santa Barbara Tax Products Group, Refund 
Advantage, Republic Bank, and River City Bank. You must adopt industry refund transfer best practice principles by charging 
customary and reasonable processing fees to be eligible. Earn a $10 credit for every federal Pay-by-Refund transaction 
funded through a participating bank from 1/1/16 thru 4/30/16 beyond the number of Pay-by-Refund transactions from the 
prior tax year. Credits will be delivered from participating banks by 5/31/16. New TY’15 customers that also qualify for free 
software will need to complete 50 funded federal Pay-by-Refund transactions before the $10 credit begins to accumulate. 
Credits will be delivered from participating banks by 5/31/16. Terms, conditions, pricing features and support for all offers 
subject to change without notice.

American Express®

*Offer only available to valid license holders of Intuit’s ProSeries or Lacerte products. Requirements to receive $15 from 
Intuit: (1) successfully register with American Express via ProSeries or Lacerte to offer the American Express Serve® Card 
(“Card”), (2) obtain the client’s acceptance of the Card terms and conditions and consent to submit the Card registration, 
(3) registration must be initiated via ProSeries or Lacerte and approved by American Express by May 15, 2016 and (4) 
a Direct Deposit of tax refunds totaling $15 or more must be made to the new Card. Joint filers are considered a single 
client making you eligible for $15 only. No payment shall be made for rejected Card registrations or tax filings. Limit of $15 
in total incentives per Card. Refunds deposited to existing Cards or any other American Express prepaid product are not 
eligible. Intuit reserves the right to recoup amounts paid (or may elect to withhold future payments) where fraud or other 
illegal activity is suspected. Payment provided by Intuit and will be made prior to December 31, 2016. Terms, conditions, 
pricing, features and support for all offers subject to change without notice.

Audit Assist
*Earn $10 for every funded Refund Transfer client you successfully enroll for first-time Audit Assistance membership 
between 8/1/15 through 4/15/16 whose refund transfer amount is sufficient to pay the $44.95 1-yr. membership fee. $10 
incentive is an introductory offer and subject to change in subsequent years. Available only to actively subscribed 2015 or 
later version ProSeries customers with an Intuit account in good standing. To participate you must be an authorized Audit 
Assistance tax preparer, enrolled via an Intuit-approved registration portal. See https://taxpro.intuit.com/client-benefit-
suite for details. Cost of Audit Assistance membership will be automatically deducted from the Refund Transfer balance. 
Individual Tax preparer credits under this offer will be collectively processed and paid not more than 12 weeks after the end 
of the then-current tax season. Offer may not be assigned, exchanged, sold, transferred, combined, or redeemed for cash or 
other goods and services. Subject to availability and additional terms and conditions may apply. Offer may be terminated 
or modified in Intuit’s discretion and terms, prices, features, services, and support are subject to change with or without 
notice. 
 
EXCLUSIONS: Not included or covered with Audit Assistance and Tax Reimbursement services are Non-resident federal 
returns; amended returns; returns other than individual 1040, including corporate, partnership, trust, estate, gift, and 
employment returns; Returns in which the tax payer or preparer had knowledge of additional taxes owed as of the 
date of enrollment in the Audit Assistance program; Returns prepared with gross negligence, recklessness, intentional 
misrepresentation or fraud; State or local returns; Returns that have become subject to IRS criminal investigations; IRS 
inquiries related to returns that address foreign income, flow-through entities (partnership and s-corporates as reported on 
Schedule K), court awards and damages, bartering income, cancelled debt, estate, and gift tax; Foreign tax credit, plug-in 
electric vehicle credit, residential energy efficient property credit, mortgage interest credit, credit to holders of tax credit 
bonds, health coverage tax credit, “Credit” for prior year minimum tax or excess Social Security tax or railroad retirement 
tax withheld; IRS inquiries and audits related to the Affordable Care Act. Tax reimbursement not available if Taxpayer or 
preparer provided incomplete, incorrect, or misleading information, or recklessly failed to include W-2, 1099, or any other 
taxable income on the return, or an inability to provide sufficient records to support any item on the return. Tax debt audit 
assistance requires that Taxpayer meet all IRS guidelines for approval and pay all associated governmental fees.

© 2015 Intuit Inc. All Rights Reserved. Intuit, the Intuit logo, ProSeries, and QuickBooks, among others, are 
registered trademarks of Intuit Inc. in the United States and other countries. Other parties’ trademarks 
and/or service marks are the property of their respective owners.
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